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Installation and Technical Information

Contents of diskette (or Download File) Installed to directory
 
 readme.txt information \rlog
 log.exe  race log program \rlog
 rlog.bat  batch file to execute score program \rlog
 rlog.ico icon for launching from Windows \rlog
 sys.ini file to hold system option settings for score program \rlog
 scropt.ini file to hold scoring option settings \rlog
 scr.ini file to hold screen format settings \rlog
 scr0.ini file to hold screen format settings \rlog
 scr1.ini file to hold screen format settings \rlog
 scr2.ini file to hold screen format settings \rlog
 scr3.ini file to hold screen format settings \rlog
 scr4.ini file to hold screen format settings \rlog
 scr1t.inifile to hold screen format settings \rlog
 scr3t.inifile to hold screen format settings \rlog
 scr4t.inifile to hold screen format settings \rlog
 scr1a.ini file to hold screen format settings \rlog
 scr2a.ini file to hold screen format settings \rlog
 scr3a.ini file to hold screen format settings \rlog
 scr4a.ini file to hold screen format settings \rlog
 scr1ta.ini file to hold screen format settings \rlog
 scr3ta.ini file to hold screen format settings \rlog
 scr4ta.ini file to hold screen format settings \rlog
 scrcust.ini file to hold screen format settings \rlog
 scrcustt.ini file to hold screen format settings \rlog           
 rsult1a.ini file to hold report parameters \rlog
 rsult2a.ini file to hold report parameters \rlog
 rsult3a.ini file to hold report parameters \rlog
 rsult4a.ini file to hold report parameters \rlog
 rsult1ta.ini file to hold report parameters \rlog
 rsult2ta.ini file to hold report parameters \rlog
 rsult3ta.ini file to hold report parameters \rlog
 rsult4ta.ini file to hold report parameters \rlog
 rsltcust.ini file to hold report parameters \rlog
 rsltcstt.ini file to hold report parameters \rlog
 sample1 sample fleet file - actual standings \rlog\data
 sample2 sample fleet file - demonstrates error checking \rlog\data
 sample3 sample fleet file - demonstrates tie breaking \rlog\data
 sample4              sample fleet file - demonstrates Team scoring \rlog\data
 rlogword.doc documentation in MS WORD for Windows 2.0  format \rlog
 rlogwp51.doc     documentation in WordPerfect 5.1 format \rlog
 rloghelp.hlp       internal file for help system \rlog
 raceform.wri   form for entering race results - MS WordPad format \rlog
 raceform.doc   form for entering race results - MS Word 2.0 format \rlog
 raceform.txt   form for entering race results - MS NotePad format \rlog 
 descript.txt         Race Log description of features  rlog
 order.txt             Race Log order form \rlog
 register.txt          Race Log registration form \rlog
 install.exe install program not copied

          

         ____________________________________________________
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ELB Software grants the purchaser the right to use one (1) copy of the Race Log software (“Software”) on a single computer, and 
to make additional copies of the Software for backup purposes only.  The Software is owned by ELB Software and is protected by 
United States copyright laws and other applicable copyright laws.  ELB Software warrants that the Software will perform 
substantially in accordance with the accompanying documentation.  ELB Software disclaims all other warranties, express or 
implied, including but not limited to, any implied warranty of merchantability or fitness for a particular purpose.  In no Event will 
ELB Software be liable for any consequential or incidental damages arising out of the use of or inability to use the Software.  In no 
case shall ELB Software’s liability exceed the purchase price paid by the purchaser for the Software.
         _____________________________________________________
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INSTALLATION of Race Log system

Diskette
 1- insert diskette into drive a: (or b:)
 2- type a: (or b:) and press Enter
 3- type install and press Enter
 The installation program assumes that you want to install on drive c:, and it creates the directory \
RLOG (or a name you select)  for the program and system files, and subdirectory \DATA for your data
files.

Downloaded
   1- Copy the downloaded file into a directory by itself. (optional).
   2- Run the self-extracting zip file by typing "rlogfile" while in the download directory, (or by double 
clicking the rlogfile.exe file while in Windows 3.1 File Manager, or Windows 95 Explorer).
   3- Type "install" (or double click the install.exe file from Windows) while in the unzipped directory 
to install Race Log, and then follow instructions.
  4- Type "rlog" (or double click rlog.bat in Windows) in the installed directory to run the Race Log 
program. 

The installation program assumes that you want to install on drive c:, and it creates the directory \
RLOG (or a name you select - different from the download directory) for the program and system 
files, and subdirectory \DATA for your data files.

NOTES ON COMPUTER SIZE

This release  of Race Log, will operate on 286 or higher computers.  You must have a Hard Drive and 
2 meg  of RAM.  If you have an older 8086 such as an IBM PC/XT you will need Race Log Release 2.0.
All future enhancements will be geared to the more up to date computers - 286 and higher (this is not 
to imply that 286's are up to date any more) since they have more memory and speed than the old 
clunkers.  If you are not sure what you have, the MEM command entered at the DOS prompt will help 
you.  This command will tell how much memory (RAM) you have and also will tell whether you have 
any Extended memory.  If you have Extended memory, then bets are that you have a 286 or better (368,
486, Pentium, etc.). 

PRINTERS

The Race Log system has been tested with Dot-Matrix printers such as the Panasonic KX-P1123, and 
Laser type printers such as Hewlett Packard Laser Jet and HP Desk Jet printers.  The system has NOT 
been tested with Post-Script type printers.

For more on printers see the section on "System Settings".

MOUSE PROBLEMS

If you have a Mouse but it is not working properly, make sure you have specified your Mouse driver in 
your AUTOEXEC.BAT file.  Many people use a Mouse in Windows 3.1 but have not used it in a DOS 
application such as Race Log.  The following AUTOEXEC.BAT file works for DOS 5.0 on a computer
where Windows 3.1 is installed:
  

  C:\WINDOWS\SMARTDRV.EXE
  @ECHO OFF  
  PROMPT $p$g
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  PATH C:\DOS;C:\WINDOWS;C\WP51;C:\RLOG
  SET MOUSE=C:\MOUSE
  LOADHIGH C:\WINDOWS\MOUSE.COM /Y
  LOADHIGH C:\DOS\DOSKEY

Note that the LOADHIGH command loads Mouse from the WINDOWS 3.1 directory  instead of the 
MOUSE directory.  This will ensure that the Mouse works when running Race Log in DOS, and also 
when launching Race Log from Windows 3.1.

Windows 95 seems to present no problems for Mouse use in DOS programs.

OPERATING SYSTEM

System Requirements
Runs on DOS 3.3 or higher (DOS 5.0 or higher is recommended for Race Log), must have hard drive 
(takes approximately 1 Meg on hard drive),  2 meg or more of memory (RAM),  IBM compatible 
computer (286 or higher for Race Log Release 2.7 and higher).
 
Notes on Microsoft Windows 3.1

Race Log can be run in a DOS box under Windows, or can be launched from Windows.  It is suggested
that you run the Race Log program in Full Screen mode.  You may try the “Window” mode, however 
the Mouse does not always work in “Window” mode.  

You can toggle back and forth between Full Screen and “Window” mode by hitting the Alt+Enter key 
combination.

To add Race Log to a Microsoft Windows 3.1 Program Group, 
· select Properties from the Windows 3.1 File menu,
· create a new Program Item for Race Log
· enter a Description such as Race Log
· enter the Command Line  -  c:\rlog\log.exe  (or your directory)
· enter c:\rlog as the Working Directory  (or your directory)
· select Change Icon to select a default icon

See also section above on MOUSE PROBLEMS.

Notes on Microsoft Windows 95

Race Log can be run in a MS-DOS Prompt Window, or can be launched from an icon  (provided on 
installation diskette) on the Desktop, or launched from Windows Explorer.  Race Log runs fine in 
either Full Screen or Window mode.  Printing your race results to a File from Race Log and then 
customizing with Windows 95 Wordpad is the easiest way to customize your output.

To create a Windows 95 Shortcut for Race Log:
· launch Windows Explorer
· select log.exe in the \RLOG directory
· click the right mouse button
· select “Create Shortcut”
· after the shortcut is created, drag it with the left mouse button from the Windows Explorer

screen to the Desktop or to a desktop folder containing your commonly used programs
· select Properties, then the Program tab
· set the working directory to your \RLOG directory
· select the icon provided in the \RLOG directory
· set “Close on exit”
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OPERATION of Race Log -- to Start Race Log

Mode 1: (assumes installed on drive c:)

 Change to the c: drive and the score system directory by entering
 
  "c:"
  "cd\rlog"  (or the directory you installed to if different than  \rlog)
 
 and then type "rlog" to run the system.

Mode 2:

Add your \RLOG directory to the PATH statement in your AUTOEXEC.BAT file if you know how, 
then reboot.  Example:

   PATH=C:\DOS;C:\MOUSE;C:\RLOG

 Then type  "rlog" from anywhere to start the Race Log system.

If you type "rlog" alone, without any filename, the system will start up without any Race Log file 
opened.  Use the "File" pulldown menu to open an existing Race Log file or to create a new one.  
Alternately, you may specify what file you want opened by entering the filename on the command line:
"rlog  fleet.dat" will start the system and open the “fleet.dat” file from the \rlog\data default directory.  
Any file which is not in that default directory must be fully qualified: "rlog  a:fleet.dat" or "rlog  c:\
somedir\fleet.dat".
 
( don't actually type the quotes in the above examples)

New in Release 1.2

1) A new SORT dialog box for sorting up to 3 columns of data in a data window.  The SORT 
capability will sort by last name in the Name column based on which name option you select in the
SORT dialog box:

  
Option: "First Last" - first name followed by last name,

example: MaryAnn  Smith        will sort by Smith
caution:  Mary  Ann  Smith       will sort by Ann

"Last, First" - last name followed by first name separated by a comma,
example:  Smith,  Mary Ann      will sort by Smith

2) Improved SAVE capability for saving your scoring methods and scoring options.

3) High Point Scoring method has been added, along with options to control how many points for 
first place, DNS, DNF, and DSQ.

4) Full TIE BREAKING has been added.

5) Corrected errors in this documentation.

6) Miscellaneous bug fixes have been incorporated into this release.
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New in Release 2.0 & 2.1

1) Corrected bugs in Tie Breaking, extensive testing has found it to be accurate

2) Corrected various bugs

4) Added Data Entry Dialog Box to increase ease of use for entering race results

5) Added Low-Point Averaged scoring method as described in US Sailing Association's 
"International Yacht Racing Rules", Appendix B2

6) Added additional documentation, and added documentation in Word and WordPerfect formats 

7) Multiple screen formats for providing the option of keeping track of additional data such as Sailing
Club or Country of origin.  Multiple report formats to provide the option of printing all or a portion
of the data.  Short report format for compact reporting handy for publishing results in magazines.

8) Added Calculator and Calendar tools.

9) Added ability to enter Override Points so you can control how many points a sailor receives in 
special scoring situations.

10) Added option to set a Race Range when scoring:  Score all races or Score selected races.

11) Added ability to create scoring subset from Standings list, ie. select top 10, top 20, etc.

New in Release 2.3

1) Added ability to enter Race Dates, and print optionally print them

2) Added ability to optionally print to a file, so report can be enhanced by a word processor or text 
editor before publishing

3) Fixed lock up problems

4)   Added new Score Methods: 
- High Point Average
- High Point Fixed
- High Point Fixed Average

5) Added ability to include Bonus for 1st, 2nd, and/or 3rd in High Point Methods

6) Ability to Include or Exclude DNS’s from scoring for High Point Methods, and ability to Include 
or Exclude all Entrants when calculating DNS score for Low Methods.

New in Release 2.4

1) Added TEAM Scoring.
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New in Release 2.5
5/28/96

1) Fixed problems with Class (subset scoring)

2) Minor enhancements to data searching routines in the “Enter Finishes” dialog box.

3) Minor corrections to documentation and Help files

New in Release 2.6
11/24/96

1) Addition of "Clear Finishes..." option in the FILE menu. This allows you to clear out the Finishes 
in a fleet file and still keep the Sailor data.  Useful for starting a new season with last years fleet 
file without re-entering all the sailors.

2) You can now Over-ride the Throwouts Percent with an actual number of Throwouts.  The number 
of races to Throw can be entered when you select "Score".  This number over-rides the Throwout 
Percent specified in the Scoring Options Setting screen for this "Scoring".

3) The actual number of Races Scored after Throwouts is listed when  you print the results.  It's listed
in the heading information where all the Scoring Options are printed.

4) The Report output width has been improved for printing to a File.  The maximum is now 157. (The
minimum is still 60).  A maximum of 157 allows for the widest printing results when using 
Windows 95 WordPad and setting the print orientation to "Landscape" with a font size  of 8. 
('Word Pad' allows for Fixed size fonts which keeps everything lined up.  Most Word Processors 
use proportional fonts which causes alignment be off a little when printing the Race Log results 
unless you manually edit the output.)

5) Bug fix for scoring files with sailors who have no Finishes entered for them.  Bug fix for 
erroneously printing a column heading of "TEAM" instead of "CLASS".

New in Release 2.7 
5/17/97

1) Create Standings report in HTML format for  inclusion on a Web site.

2) Added “Bonus Point” scoring method - actually the same as previously supported “Olympic” 
method.

3) Upgraded  support of DNC, DNS, DNF, OSC, RET, DSQ, and DND to the precise definition of 
each as specified in the new 1997 Rules.   Formerly a DNS was treated as a Did Not Compete, and
a DNS was the default Finish if nothing was entered for a race.  Now a DNS means the racer 
showed up at the starting area, but Did Not Start.  A DNC is now the default entry for a racer who 
did not show up and will automatically be filled in for non-competing yachts in a series. 
 

4) Extended the ability to specify whether the penalty is to be added to the number of Entrants, 
Starters, or Finishers to all of the above penalty indicators.

5) Expanded the “Class” and “Team” column to 3 characters.

6) Added column for “State”, “Member”.
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7) Added ability to customize screen layout and report layout by selecting which columns to display, 
in addition to the preset screen layouts already provided.

8) Added ability to report the “Total Points” (score before removing Throwouts), in addition to the 
“Score” for Low Point Method.

9) Added Conversion program to convert old Race Log fleet files to new  format.  This will occur 
automatically when you open an old file.   The old file will automatically be updated, and will not 
be readable by your old Race Log release (Release 2.6 or older).
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Entering Race Results
Quick Start for New Race Log Users

· Open an existing file of fleet data using the "File" | "Open" menu option, or create a new file using
the "File" | "New" menu option.  

· Enter your sailor's Name and/or Sail Number along with their Finishes in the appropriate Race 
column on the screen, or select the “Edit | “Enter Finishes…” menu option and Race Log will 
prompt you for each finish starting with the First finisher.  

· Before you score the results you need to select your scoring method (such as Low Point) and 
scoring options (such as throwouts).  Select the “Options” | “Score Method” menu selection and 
fill in the appropriate information.  When done, click “Save” at the bottom of the Options screen 
so you won’t have to do this again the next time you Score your Fleet.

· Select "Score It" from the "Score" menu.  Your fleet will be scored and standings will be 
displayed on the screen.  

· Print the results by selecting "Print All" from the "Print" menu.   That's it!  
· Race Log automatically computes your scores including all Penalties, Tie breaking, and 

automatically computes Throwouts (including not throwing out a DND).

Data Entry Overview

The Race Log system works similar to a word processor or spreadsheet system in that your data can be 
entered in a full screen edit mode.  Use the Home key to move the cursor between the Command Line 
and the Data area.  There is no particular order of entry required - partial names or Sail numbers can be
entered and updated later; finishes can be modified at any time; records can be deleted or added at any 
point in your data entry process.  Save your data using the “File” pulldown menu, or type the “save” 
command on the Command Line.  You will be asked to save if you try to quit but forgot to save your 
data. 

The Race column is where you enter a racer’s Finishing position, or DNC, DSQ, DNF, etc..  Actual 
points earned by the racer are automatically calculated by Race Log.  ( Occasionally it is necessary to 
override the actual points a sailor earns for his finish.  This situation can occur if you have a protest 
and need to adjust scores, or if you provide series credit for sailing in out of town regattas.  For 
information on Override Points see the Override Points section.) 

Again, similar to a word processor or spreadsheet, you can edit an existing file containing race results, 
or you can create a new file, and you can have more than one file open at the same time which is handy
for comparing to a previous year's data.  Open an existing score file or create a new one by making the 
appropriate selection from the “File” pulldown menu.

Race results can also be entered using the “Enter Finishes” dialog box on the “Edit” pulldown menu.  
This will prompt you for the next finish in the next race.  All you do is enter the Name or Sail number 
of the racer.

Data Entry Specifics - Full Screen

Enter racing data by typing in the data screen under the appropriate columns.

The Home key will move the cursor back and forth between the Command line (where you can enter 
commands) and the Data area of the screen (where you can enter and edit data).

After entering the sailors Names or Sail Numbers you may want to Sort the list of names by last name 
(see the SORT dialog box in the EDIT pulldown menu) or by Sail Number so that you can more easily 
find the sailor you are entering results for.  Make sure you Save your data to keep it in your Sorted 
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order.

The mouse can be used to place the cursor anywhere on the screen where you need to enter or change 
data.
  
The Tab key will move the cursor to the next column, Shift/Tab will move to the previous column.

The Arrow keys will move the cursor around the screen.

The Enter key is a little different than a word processor, it will take you to the next line but it does  not 
insert data onto the following line like a word processor.  It will, however, create a new record (new 
line) if you hit the Enter key while on the last record in the file.  Also the Enter key will remember 
where you started typing on a line and position you on the next line underneath where you started 
typing.  This is handy for entering multiple finishes for a particular race since Enter will keep you in 
the same Race column.

The Insert, Delete, and Backspace keys work as you expect them in a word processor.

The “Insert” and “Delete” entries on the “Edit” pull-down menu will insert or delete a line (or record).
First, place the cursor on the line you want to delete, or place the cursor on the line where you want to 
insert a new record and then select the “Insert” or “Delete” option.   (Also see Keyboard below:  F2, 
Ctl+F2, and Ctl+Del.)

Insert and Overtype mode when typing.  You can tell what mode you are in by the size of the cursor.  If
the cursor is an underline then you are in insert mode.  If the cursor is block shaped then you are in 
overtype mode.  You can change between Insert and Overtype mode by pressing the Insert Key.
When entering finishes in the Race columns the system will always automatically overtype what was in
that column whether you are in Insert or Overtype mode.  The Insert and Overtype modes act in a more
normal word processor fashion in the other data columns - such as Name, Class and Number (sail 
number)
. 
Any Race column left blank will automatically be scored as DNC.  This will also happen if a 0 or bad 
data is entered in a Race column.  You only need to fill in the finishes for those who actually started a 
race, this includes DSQ and DNF - these must be entered.  DNC may be entered if you chose.

Race dates will appear on the first line under the column heading.  If the Race Date line is not there, 
select “Add Race Dates” from the “Edit” pulldown menu.   Then use the mouse to click under the 
column heading for a specific race.  A dialog box will open for you to enter a date.  The following 
formats may be used to enter a date:    mm-dd-yy,  mm/dd/yy, mmddyy.  (Examples:  012996,  
1/29/96, 1-29-96).

Data Entry Specifics - “Enter Finishes” Dialog Box

Select the "Enter Finishes" dialog box from the "Edit" pulldown menu.

The Race Log system will:
Automatically determine the current race:

· Positions you at the next Race to enter (RC_9, RC10, etc)
· Prompts you for the Finish to enter (1st, 2nd, etc)

You type the racer's:
· First Name and/or
· Last Name and/or
· Sail Number

  (You can enter an abbreviation such as "Al" for Albert.   “Al   “  will find Al.   The 
Status line will tell you if there is an error.  Don’t type the quotes.)

13



Then click the “Do It” button, (or Tab to the button and press Enter, or use the Hot key of Alt-d).  Data 
will automatically be updated in the data window when you "Quit" the Enter 
Finishes Dialog Box.

Use the “Add” button to add a new racer.  When you enter a new racer's Name or Sail Number and that
sailor is not found, the Status line will tell you that no Sailor is found.  Then click “Add” to add the 
sailor (of Tab to the button and press Enter, or use the Hot key of Alt-a).

The RACE:  box in the upper left will automatically position you at the next race to enter.  You may 
override this by clicking the Arrow buttons or by typing in the specific Race you wish to score or 
correct. (Or type RC_3, RC12, etc,  use the underscore is for RC_1 thru RC_9).

The Finish box in the upper right will automatically prompt you for the next finish.  You can override 
this by typing into the box (“1” for 1st, “2” for 2nd, dnf, etc.), or click on the “DNC”, “DSQ”, or 
“DNF” buttons.  DNC's are assumed if no finish is entered.

The Date: entry can be left blank or can be used to enter a race date.  Tab to the Date: entry and start 
typing a date, or mouse click the Date: area and a dialog box will open for entering a date.

Click on the “Quit” button when you have finished entering your scoring data (or Tab to the “Quit” 
button and then press Enter, or use the Hot key of Alt-t).

Clear Finishes from Existing File

You can re-use an existing fleet file and save yourself the effort of re-entering the Sailor’s name and 
sail number.  To clear  the race finish data from a file and leave the Sailors intact select “Clear 
Finishes…” from the “File” pulldown menu.  Use “Save” to write over the existing file and lose the 
original finishes.  Use “SaveAs” to write to a new file and keep the cleared finishes in the original file.

Be careful to ensure you don’t have extraneous, or inactive Sailors in your fleet file if your are 
counting all Entrants in a series.  Every sailor in the fleet file is considered an Entrant in your series 
whether they have finishes recorded or not.  For more information on this issue see the “Scoring 
Options” Section.
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Scoring
How to Score

Once your data is entered simply type “score” on the command line or select "Score It" from the 
pulldown menu.  The finishes in the data window will be checked for errors and a new window will 
appear with the resulting scores and standings.  Notice this window has no command line at the bottom
and you cannot edit the data in this window, this is a result or report window.   You may use the 
Mouse or scroll keys, F8 and F9 for left and right scrolling, and the Page Up and Page Down keys, to 
view the results. 

Next you may print the results by selecting the "Print All" from the "Print" pulldown menu.  You will 
be prompted for a new title, just hit the Enter key or click the OK button to use the default title.  (Don't
click on CANCEL unless you want to cancel the Print request.)  You're done. 

Don't forget to save your data.  The result window isn't actually data, you must get back to the data 
window and type "save" on the command line or select "Save" from the pulldown menu.  The data file 
and data window will always contain exactly what you enter.  Conversions to scores such as DNC's, or 
scoring 1st as .75 will be done automatically by Race Log and then used in calculating your total 
Score.  However the data in the file will not actually change to .75, it will stay "1" in the data file.

Penalty Scoring

Race Log uses the following definitions for penalties as specified in Appendix A of the most recent US
Sailing “International Yacht Race Rules”,  Race Log automatically computes the score for each 
penalty based on your settings for the Scoring Options for your scoring method, see the section on 
Scoring Options for more information:

  DNC - Did not compete, did not come to the starting area
  DNS - Did not start, but came to the starting area
  OCS - On course side, over early
  DNF - Did not finish
  RET - Retired after finishing
  DSQ - Disqualified
  DND - Disqualified not discardable, can't be a throwout
  RDG - Redress given, (Note: 'RDG' not actually entered
       into Finish, however Race Log handles RDG by
       allowing the scorer to actually enter the Over-ride 
       Points instead of the Finish position, see the section
       on Override Points for more information on entering
       actual score values.
  ZPG - Z flag given, (Note: 'ZPG' not actually entered
       into Finish, however Race Log handles ZPG by
       allowing the scorer to actually enter the Penalty
       Points, see the section on Override Points for more
       information on entering penalty score values.

Override Points

Situations arise which require that you override the points calculated for a racer by Race Log.  This 
situation can occur if you have a protest and need to adjust scores, or if you provide series credit for 
sailing in out of town regattas, and so forth.  Since the data you normally enter is the actual finish, you 
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need to let Race Log know that the number you enter is either a “finish” or actual “points”.  The 
default is “finish”.  If you must enter Override Points, enter the “points”  you want the racer to earn in 
the appropriate Race column.  Include the decimal point whether you enter a whole or fractional 
number.  A maximum of 1 digit is allowed after the decimal.  This is done in the Data window, not the 
Enter Finishes dialog box. 

   Examples of valid Override Points entered in a Race column:  2.5     2.0      3.     8.1  
   Examples of invalid Override Points:     2       3.55

The decimal point must be included or Race Log will assume you have entered the racer’s “ finish”.  An
error message will indicate a problem with too many decimal points.  You may need to turn off Error 
Checking (see Error Checking section) if your scoring situation results in gaps in your finishes, such as 
no 3rd place finisher.  This is a condition which is automatically checked for by Error Checking.  You 
may need to turn it off before Scoring by selecting “Options” | “Error Checking”.

     for Low Point, Low Point Averaged, and Olympic Methods:   The Override Points you enter are 
actual points earned for that race.

     for High Point Method:   The Override Points you enter are not actual points, but represent a 
compromise finish.  If you enter   2.5   then the Race Log program will treat this as a finish 
between the 2nd place finisher and the 3rd place finisher and calculate points based on that 
sequence of finishers. 

Set Race Range

This Dialog box appears when you select the “Score It” menu selection to Score your fleet.  The 
default of "All Races" is pre-selected.   Or a specific range of races to be scored can be selected, such 
as the past weekend’s results, by clicking the "Select Race Range" option.  Then use the Arrow 
buttons to set the Starting and Ending race you wish to Score.  Re-selecting the "All Races" option will
reset the Starting and Ending races to include ALL races.

Normally you will Score all races to establish standings for all of your scoring data.  Or you may select
a subset of races and establish standings based only on those selected races.  This allows you to keep 
all your fleet data for a whole season in one file, and optionally score the whole season or score a 
specific weekend from the same data file. 

Throwouts

Race Log will exclude from scoring a racer’s worst finishes.  This is done by specifying a “Percentage”
of races to throw in the Scoring Options dialog box.  Select “Score Option Settings…” from the 
“Options” pulldown menu.  The percentage entered (20 for 20%) will be rounded down to ensure that 
no more than the specified percent will be thrown.

Each time you score you have the opportunity to over-ride the Throwouts Percent with an actual 
number of races to throw.  You may enter any number 0 or greater to indicate how many races to throw
from this scoring.  This number is entered in the “Score” dialog box.  Leave the over-ride entry field 
blank to use the Throwouts Percent you set in the “Score Option Settings…” dialog box.

For more information on Throwouts for you selected Scoring Method see the section on Scoring 
Options.

Error Checking
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If there are any errors in your scoring data they will be found when you Score.  Error messages will be 
displayed indicating the problem.  Race Log will check for:

· missing finishes
· duplicate finishes
· finishes higher than the number of participants
· minimum participation requirements
· inconsistent throwout option

Correct the errors  and then re-Score.

Error Checking can be turned off by selecting “Options” | “Error Checking”.  This is useful if duplicate
finishes need to be entered in special scoring situations.  If you need to score in this manner, it is wise 
to first score with Error Checking on just to check your data.  Then turn Error Checking off to produce 
your standings. 

Error checking is automatically disabled while scoring subsets (Class or Division) to compensate for 
missing finishes.
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Scoring Options
Scoring Method and Settings

Scoring Method:  This is set by choosing "Score Method"  from the "Options" pulldown menu.  You 
may select one of:

· Low Point
· Low Point Averaged
· High Point
· High Point Averaged
· High Point Fixed
· High Point Fixed Average
· Bonus Point

Many scoring options settings are available for each Method.  The current settings will be displayed.  
Or select "Score Settings" from the "Options" pulldown menu to view the Options settings.

Once you have the Scoring Settings dialog box available you may Tab to the option you want to change
or click the mouse anywhere on the option.  Once you have made your changes you may click on the 
"Set" button (or Tab to the “Set” button and hit Enter) to change the settings for the duration of your 
current Race Log program session.  Click on "Save" to permanently save the new settings.

High Point Method:  
A First receives the highest score.  Each yacht is scored one point for finishing (see Finish Bonus) and 
one point for each starting yacht it beats.  Each yacht's score is totaled and the highest score wins.   
Throw-outs in this method don't make sense so  they are not calculated.
  
Options for High Point Score Settings...
 
Finish Bonus =:  This specifies how many points to add to each Finishing yacht.  This is typically 1, 
however the number can be changed here.  A yacht's score is the number of  yacht's it beats plus this 
bonus.

Start Bonus =:  This specifies how many points to add to each Starting  yacht.  This is typically 0, 
however  number can be changed here.  A Start bonus makes non-attendance more severe 

Bonus for 1st, 2nd, 3rd:   A partial point bonus, such as .25, or any decimal number less than 1, will 
be added to each 1st (or 2nd, or 3rd).  Each bonus may be a different value or 0.
 
DNC:    This value specifies how many points will be scored for a non-starter.  This is usually set to 0 
for the High Point Method since usually only Starters are calculated in the score.  

MORE..  Click here to set whether non-Starters, (DNC's), are counted as beaten yachts in the High 
point scoring.  The default is *Not Counted*.   If set to Counted, then non-Starters  are counted as 
defeated in races in  which they did not start when calculating a score.
 
DNS, DNF, RET:   This value specifies how many points will be scored for a Did Not Start, Did Not 
Finish, and Retired. This is usually set to 1 for the High Point Method.
 
DSQ, DND, OCS:   This value specifies how many points will be scored for a Disqualification, 
Disqualified Not Discardable, and On Course Side (Over Early) usually a 1, but greater than a DNC.
 
Minimum Starters:   This tells the Race Log system not to score a race below a minimum number of 
racers.  An error message will alert you to this condition when scoring.
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% of Races to Qualify:   Used to ensure that a racer has sailed in the specified percentage of the total 
number of series races in order to qualify for a series.  Enter 0 if no checking is required.  This is 
usually set to a percentage > 0 on the last  "scoring" of the season to produce the final standings. 
If a racer started in less than the required % of races, then he will not have a total score (“NC” for not 
counted).  He may, however, be counted at a participant based on the setting of  “More” above.  This 
will  affects the DNC, DNF, DSQ, etc. scores.  This keeps the scores of the qualifiers from changing 
when you switch from scoring without, to scoring with the % Qualified turned on.
This option is not as important for High Point as other methods since participation is rewarded with 
points.

High Fixed Point Method:   
A First receives the highest score.  This score is pre-set by the  race committee and set in the {Top 
Score} box.  Each subsequent finisher is scored one point less than the yacht ahead.  Each yacht's score
is totaled and the highest score wins.  Throw-outs in this method don't make sense so they are not 
calculated.  If the Top Score is less than the number of Starters, Race Log will use the number of 
Starters as the Top  Score.

  See High Point Method above for option settings.

High Fixed Point Average Method:   
A First receives the highest score.  This score is pre-set by the  race committee and set in the Top 
Score.. box.  Each subsequent finisher is scored one point less than the yacht ahead.  Each yacht's score
is totaled and divided by the number of races it starts.  The highest score wins.  Throw-outs in this 
method don't make sense so they are not calculated.  If the Top Score is less than the number of 
Starters, Race Log will use the number of Starters as the Top  Score.

  See High Point Method above for option settings.

High Point Average Method:  
A First receives the highest score.  Each yacht is scored one point for   finishing (see Finish Bonus) and
one point for each starting yacht it beats.  Each yacht's score is totaled and divided by the number of 
races it Starts.  The highest score wins.  Throw-outs in this method don't make sense so they are not 
calculated.

  See High Point Method above for option settings.

Low Point Method:  
A First receives the lowest score, usually 1 or .75, based on your settings in the Scoring Settings.  A 
Second receives a 2, and so on, as specified by US Sailing Association's "International Yacht Racing 
Rules".  A racer's standing is based on the sum of his finishes counted.  This method is the most popular
scoring method.  However this method usually will require using the Throwouts option for scoring a 
whole season where weekly participation varies.

Throwouts:  This setting establishes the percent of races to throw out.  The result window will show 
how many points each racer has earned for his/her best races not thrown out.  Races will be thrown 
starting from the lowest scores per racer including DNC's.  In addition to regattas, this entry is helpful 
for seasonal scoring to address the fact that most entrants will miss some of the races.  A setting of 20 
indicates 20%.  If 20% represents a fractional number then the number of throwouts is rounded down.

First Place Points:  This is usually set to 1.00 or .75 for Low Point (Other numbers can be entered just
for fun).
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DNC = Entrants +:  The Did Not Compete penalty equals the number of Entrants (or Starters - see 
MORE..) plus the penalty number entered here.  This is typically 1 or 2 for the Low Point Method.

MORE..   Click here to set whether the DNC penalty will be added to the number of Entrants in the 
Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race.

DNF = Starters +:   Penalty for those receiving a Did Not Finish.  This will be added to the number of 
starters (se MORE..) for each race.  The number of starters may be different for each race, and may be 
less than the number of entrants.  This is typically 1 for Low Methods.

MORE..   Click here to set whether the DNF penalty will be added to the number of Entrants in the 
Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race, or the 
number Finishers (only for Low Point) in a given race..

DNS, RET = Starters +:  Penalty for those receiving a Did Not Start, or Retired.  This will be added 
to the number of starters for each race.  The number of starters may be different for each race, and may
be less than the number of entrants.  This is typically 1 for Low Methods.

MORE..   Click here to set whether the DNS, RET penalty will be added to the number of Entrants in 
the Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race.

DSQ, DND, OSC = Starters +:  Penalty for those receiving a Disqualified, Disqualified Not 
Discardable, and Retired.  This will be added to the number of starters for each race.  The number of 
starters may be different for each race, and may be less than the number of entrants.  This is typically 1
for Low Methods.

The “More” setting for “DNS, RET” also applies to “DSQ, DND, OSC”.

Minimum Score for DNC:  Use this setting to set a minimum score which will be used if the number 
of entrants in a fleet varies widely from week to week.  A setting such as 10, for example, will level the
DNC penalty scores.

Minimum Starters:  This tells the Race Log system not to score a race below a minimum number of 
racers.  An error message will alert you to this condition when scoring. 

% of Races to Qualify:   Used to ensure that a racer has sailed in the specified percentage of the total 
number of series races in order to qualify for a series.  Enter 0 if no checking is required.  This is 
usually set to a percentage > 0 on the last  "scoring" of the season to produce the final standings. 
If a racer started in less then the required % of races, then he will not have a total score (“NC” for not 
counted).  He is, however, counted as an entrant in the series.  This affects the DNC, DNF, etc. scores 
if these penalties are to be added to the number on Entrants.  See “More” settings above.
This option is useful for the Low Point method for seasonal scoring to ensure that a minimum 
participation is achieved.

Low-Point Averaged Method:  
A First receives the lowest score, usually 1 or .75, based on your settings in the Scoring Settings.  A 
Second receives a 2, and so on.  This method is described in Appendix B2A of US Sailing's "1993-96 
Internamtion aYacht Racing Rules".  A racer’s standing is based on the average of his finishes counted.
This method does not reward participation so use of the ”% of Races to Qualify” option is necessary to 
score an extended series to prevent a one or two time winner from walking away with a series.  DNC's 
are not calculated in the score, just the races which are started.  A race which is not attended is 
considered not scored

Throwouts:  This setting establishes the percent of races to throw out.  The result window will show 
how many points each racer has earned for his/her best races not thrown out.  Scores are thrown 
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starting from the worst scores per racer not including DNC's.  DNC's are not considered as part of the 
score in this method.  Using a percentage implies that each racer may receive a different number of 
throwouts depending on how many of their races are scored.   A setting of 20 indicates 20%.  If 20% 
represents a fractional number then the number of throwouts is rounded down.

First Place Points:  This is usually set to 1.00 or .75 (Other numbers can be entered just for fun).

DNC = Entrants +:  This value is not used in the Low-Pt Averaged method.  DNC's are not calculated 
in the score, so the "% of Races to Qualify" setting is necessary in order to insure accurate and fair 
scoring.

MORE..    Has no effect for Low Point Averaged method.

DNF = Starters +:  Penalty for those receiving a DNF.  This will be added to the number of starters 
for each race.  The number of starters may be different for each race, and may be less than the number 
of entrants.  This number is typically 1 for Low Methods.

MORE..   Click here to set whether the DNF penalty will be added to the number of Entrants in the 
Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race, or the 
number Finishers (only for Low Point) in a given race..

DNS, RET = Starters +:  Penalty for those receiving a Did Not Start, or Retired.  This will be added 
to the number of starters for each race.  The number of starters may be different for each race, and may
be less than the number of entrants.  This is typically 1 for Low Methods.

MORE..   Click here to set whether the DNS, RET penalty will be added to the number of Entrants in 
the Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race.

DSQ, DND, OSC = Starters +:  Penalty for those receiving a Disqualified, Disqualified Not 
Discardable, and Retired.  This will be added to the number of starters for each race.  The number of 
starters may be different for each race, and may be less than the number of entrants.  This is typically 1
for Low Methods.
The “More” setting for DNS, RET applies to DSQ, DND, OSC.

Minimum Score for DNC:  Not used for this method.

Minimum Starters:  This tells the Race Log system not to score a race below a minimum number of 
racers.  An error message will alert you to this condition when scoring. 

% of Races to Qualify:  This specifies the percentage of all races in which a racer must participate in 
order to qualify for the series.  This is generally set to 0 to allow all racers to be included in day to day 
or weekly scoring for a long series, however this may provide inaccurate standings for the Low-Pt 
Averaged method.  This setting is extremely important for this method since only the races started are 
included in the scoring calculation.  If a racer has one 1st and then all DNC's then he would be in first 
place (or tie for first) unless this setting sets a minimum participation requirement.  

Bonus Point Method:  
A First receives 0, Second - 3, Third - 5.7, Fourth - 8, Fifth - 10, Sixth - 11.7, Seventh and thereafter - 
Place + 6 as specified in by US Sailing Association's "International Yacht Racing Rules".  A racer’s 
standing is based on the sum of his counted finish scores, higher finishes being penalized as the above 
scores indicate.  This type of method is call a “spread” method since there is a bigger spread between 
1st and 2nd for example, than between 10th and 11th.  The reasoning is that it is harder to move from 2nd

to 1st than from 11th to 10th.

Throwouts:  This setting establishes the percent of races to throw out.  The result window will show 
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how many points each racer has earned for his/her best races not thrown out.  DNC's will be the first 
races to be thrown out.

First Place Points:  Bonus Point is automatically set to 0 points but you may override this.  

DNC = Entrants +:  The Did Not Compete penalty equals the number of Entrants (or Starters - see 
MORE..) plus the penalty number entered here.  This is typically 1 or 2 for the Bonus Point Method.

MORE..   Click here to set whether the DNC penalty will be added to the number of Entrants in the 
Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race.

DNF = Starters +:   Penalty for those receiving a Did Not Finish.  This will be added to the number of 
starters (se MORE..) for each race.  The number of starters may be different for each race, and may be 
less than the number of entrants.  This is typically 1 for Bonus Point Method.

MORE..   Click here to set whether the DNF penalty will be added to the number of Entrants in the 
Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race, or the 
number Finishers (only for Low Point) in a given race..

DNS, RET = Starters +:  Penalty for those receiving a Did Not Start, or Retired.  This will be added 
to the number of starters for each race.  The number of starters may be different for each race, and may
be less than the number of entrants.  This is typically 1 for Bonus Point Method.

MORE..   Click here to set whether the DNS, RET penalty will be added to the number of Entrants in 
the Series (i.e. the number of sailors in the fleet file), or the number of Starters in a given race.

DSQ, DND, OSC = Starters +:  Penalty for those receiving a Disqualified, Disqualified Not 
Discardable, and Retired.  This will be added to the number of starters for each race.  The number of 
starters may be different for each race, and may be less than the number of entrants.  This is typically 1
for Bonus Point Method.

The “More” setting for DNS, RET applies to DSQ, DND, OSC.

Minimum Score for DNC:  Use this setting to set a minimum score which will be used if the number 
of entrants in a fleet varies widely from week to week.  A setting such as 10, for example, will level the
DNC penalty scores.

Minimum Starters:  This tells the Race Log system not to score a race below a minimum number of 
racers.  An error message will alert you to this condition when scoring. 

% of Races to Qualify:   Used to ensure that a racer has sailed in the specified percentage of the total 
number of series races in order to qualify for a series.  Enter 0 if no checking is required.  This is 
usually set to a percentage > 0 on the last  "scoring" of the season to produce the final standings. 
If a racer started in less then the required % of races, then he will not have a total score (“NC” for not 
counted). He is, however, counted as an entrant in the series.  This affects the DNC, DNF, etc. scores if
these penalties are to be added to the number on Entrants.  See “More” settings above.
This option is useful for the Low Point method for seasonal scoring to ensure that a minimum 
participation is achieved.

Note:  You may want to score your data using more than one method in order to compare the results of 
different methods.  After you score the data using "Score It" from the pull down menu or by typing the 
"score" command, you may change the method as described above.  Then get back to your data window
and "score" again.  You will now have two result windows to compare.  You can create as many 
scoring result windows as you need. 
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Printing
Print to Printer

Any window including the data windows and score result windows can be printed by selecting any of 
the options from the "Print" pulldown menu.  "Print All" prints everything in the active window.  This
is normally the option you will select to print your score results.  "Print From/To" prompts you for a 
range of line numbers to print such as "3   12"  - this prints record/line 3 through 12 from the active 
window.  

"Print Score Option Settings" prints the scoring options which are currently in effect. 

"Set Report Printing Options…" on the "Print" pulldown menu asks whether you want to print the 
scoring options settings at the front of your Race Log printout.  This is usually set to “Yes”.

When you Print you will be prompted for a new title for your report.  You may leave it blank, and click
OK to use the default report title.   (Don't click on CANCEL unless you want to cancel the Print 
request.)  

Laser or Desk Jet printers sometimes behave differently than Dot Matrix printers.  Set the printer type 
in the "System Settings" selection on the "Options" pulldown menu.  You may need to experiment 
with this if you are having problems with printed output.

Print to File

The default is to print to a Printer.  You may optionally print to a file so the output can be manipulated 
prior to publishing using a word processor or text editor.   Select “Set Print to File Options…” from 
the “Print” pulldown menu.  Then click ( )File, click the down arrow or type in a file name.  The 
down arrow will display a history list of previously entered file names which you may wish to reuse.   
Suggestion: Enter or select a file name with a “.txt” extension.  This will make it easier to open the file
by double clicking from Windows 3.1 File Manager, or Windows 95 Explorer.  The print width can be 
modified so that you can control wrapping of finishes on the print page.  

The default page width is 66 which is appropriate for printing from Windows “Notepad”.  Valid 
entries range from 60 to 157.  Select a wider page width of up to 157 for printing with a small font in a 
word processor, Windows 95 “Wordpad”, or Text Editor.  A maximum of 157 allows for the widest 
printing results (without wrapping to a new line) when using Windows 95 “WordPad”. 

Windows 95 “Word Pad” provides one of the best printing tools since it allows for Fixed size fonts 
which keeps the output lined up in a columnar fashion.  A maximum of 157 allows for the widest 
possible printing results when using Windows 95 “WordPad”.  While in WordPad set the print 
orientation to "Landscape", with a font size of 8.  This is the most effective way to print Race Log 
results and customize your output.  Most Word Processors use Proportional fonts which causes 
columnar alignment to be off a little when printing the Race Log results.  See also What's new in 
Release 2.6 

The print file created by Race Log will be put into your /RLOG directory.

HTML Format

File printing in HTML format can be specified for publishing Race Log results on a Web Site.  Select 
“Set Print to File Options…” from the “Print” pulldown menu, then select  “( )File - HTML 
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Format”.  The page width will automatically be changed to 83.  You may change this.  However 
testing has shown this size works well with most Web Browsers.  You will also be prompted to enter a 
file name with a “.htm” extension. Click the down arrow or type in a file name.  The down arrow will 
display a history list of previously entered file names which you may wish to reuse.  You must use the 
“.htm” file extension preceded by up to eight characters  (example file names:  print.htm   
results.htm ).  

You can preview what the report will look like on the Internet if you have a Web Browser installed.  
Double click the “file.htm” you just created using your Windows 3.1 File Manager, or Windows 95 
Explorer and your Browser should fire up displaying your report.

The file is ready to be added to a Web Site and Linked to.

The print file created by Race Log will be put into your /RLOG directory.
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Splitting Fleets into Separate Divisions
Class or Division

You may keep track of multiple Classes or Divisions of sailors in the same fleet file.  You may score 
them separately or score all Classes or Divisions along with the whole fleet.  An example of this is 
"Junior" sailors racing with your fleet.  Simply score their actual finishes to see how they stand within 
the whole fleet.  Indicate they are Juniors by typing something in the Class column such as "jr".  Select 
"Select Class" from the "Score" pulldown menu and enter "jr" for your selection criteria.  You may 
select up to two values to create a new subset window representing a new Class..  (The Race Log 
system disregards Upper vs. Lower Case in searches.)  A new window with the subset of “juniors’ you 
selected will appear.  You may also get a message indicating that the data could not be found.  Once 
the window appears simply score this group as described above.  The only difference in scoring a 
subset is that you will be asked if you wish to have the subsetted racers scored using their actual 
finishes or with their finishes converted relative to 1.  You may optionally use “SaveAs” to save the 
data in the subset window to a separate file.

When you score a subset window, you will be asked if you wish to score “Relative to One”.  If you 
chose YES you will eliminate the gaps in finishes due to the fact you aren’t scoring the whole fleet.  
The finishes will be converted to 1 through ….n for the standings.  The data in the fleet file is NOT 
changed however.  If you chose NO for “Relative to One” then the finishes will not be altered.  The 
resulting score will be identical to the score a racer receives in the whole fleet scoring.  In order to 
perform scoring of a subset window with NO for “Relative to One”, Race Log requires that you first 
score the whole fleet.  Race Log will provide a warning message if you haven’t done this.

Select Top Finishers

Select the "Select Top Finishers.." menu item from the "Score" pull-down menu.  This option is used 
to select the Top 10, Top 20, Bottom 10, or any other range of Finishers.  The range of finishers is 
selected from the Score Result Window which displays your standings.  You can Score this new 
collection of racers.  As with any SCORE'ing from a subset window you will be asked if you want to 
convert the scores relative to 1. You may optionally use “SaveAs” to save the data in the subset 
window to a separate file.

Custom Selection

You may use the “Select” command (see Commands below) to split a fleet apart using your own 
selection criteria.  Example:

     Select IL in St

This command will create a new window with only sailors from the State (St) of Illinois (IL) by 
selecting the IL’s from the St column.  This subset may be scored separately.  Scoring will work as 
discussed above in the “Class or Division” paragraph.
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Commands
You may enter these commands on the command line. (Ignore Case except when entering Column 
names).

SCORE SCORE      to score (same as selecting from pulldown menu).

FIND FIND "CHARLIE"     to locate Charlie in your data window, the search 
always starts at the beginning of the file and searches all columns and 
records.  The quotes are optional. 

 
FIND CHARLIE in Name     to locate a record with Charlie's in the Name 
column.
FIND 1 in RC_9      to locate the winner of the ninth race.

FINDN FINDN RALPH      to Find the Next occurrence of Ralph after an initial 
FIND command positions you into the data. 

***  FIND and FINDN(ext) are repeatable commands.  Just hit the Enter key after a FIND in order to 
repeat the FIND.

LOCATE LOCATE 15       positions you at the 15th record or line in the active 
window.

PRINT PRINT                to print the active window, can be a data window or a 
result window with standings

SELECT SELECT "JR" IN Class         to create a subset window with Junior racers. 
SELECT "SMITH" IN Name     to create a subset window with all the 
Smith's who are in the data window. ( IN limits your search to a Column; all 
data columns will be searched if you don't use the IN parameter.)  

TOP TOP       to position you to the top, or first record in your active window.

BOTTOM BOTTOM      to position you to the bottom, or last record in your active 
window.

REMOVEID REMOVEID (or abbreviate to RID)        to remove the current window.
RID 03         to remove the window labeled with ID 03.

CHANGEID CHANGEID 03 (or abbreviate to CID)      to switch to the window labeled 
ID 03.

SORT SORT Class       to redisplay your race data in sequence by Class, this will 
group together racers in the same Class.  Up to 3 classes may be entered to 
do sorts within sorts.   
SORT  Class  Number     to sort by Sail Number within Class.

                                         SORT RC_2       to sort by the finishes in Race 2,  ie. show the standings for
Race 2 only.

SAVE SAVE       saves the data in the currently active window (same as selecting 
SAVE from the FILE pulldown menu). 
The file will be saved in the \RLOG\DATA directory unles you type in a 
specific path.
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SAVEAS SAVEAS  A:FLEET.DAT      saves the data in the currently active window 
into the specified file which may or may not already exist.  You will be 
asked permission to overwrite an existing file.  This is a handy way to create
a backup of your fleet onto a floppy disk  (same as selecting SAVEAS from 
the FILE pulldown menu).
The file will be saved in the \RLOG\DATA directory unles you type in a 
specific path.

SAVEONTO SAVEONTO A:BIG.DAT      saves the data in the currently active window 
onto the end of the specified file.  You will be prompted if the file does not 
exist in order to create a new one.  This will allow you to add racers to the 
racers on an existing file, but it does not add races onto an existing file  
(same as selecting SAVEONTO from the FILE pulldown menu). 
The file will be saved in the \RLOG\DATA directory unles you type in a 
specific path.

Many of the above actions can be accomplished by mouse clicks such as clicking on a partially hidden 
window to bring it to the front (the CHANGEID command).

Each command can be abbreviated by typing enough of the command to make it unique from another 
command such as L for LOCATE.  But S for SAVE is not unique due to SAVEAS, SAVEONTO and 
SELECT.  In addition the CHANGID and REMOVEID commands have special abbreviations as 
indicated.
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Keyboard Map and Hot Keys
(letters may be UPPER or lower case)
 
 Alt-E       invoke Edit menu
 Alt-H       invoke Help menu
 Alt-F        invoke File menu
 Alt-O       invoke Options menu
 Alt-P       invoke Print menu
 Alt-S       invoke Score menu
 Alt-W       invoke Window menu
 Alt-X       Exit Race Log
 Arrow(s)    moves cursor
 Delete      deletes character at cursor
 Ctl-Delete  deletes record at cursor
 F1          invoke Help for current context
 F2          insert record before cursor
 Ctl-F2      insert record after cursor
 F3          repeat character from line above
 F4
 F5          turn off indenting for Enter key
 F6          next window
 F7
 F8          scroll one page left
 Ctl-F8     scroll to far left
 F9          scroll one page right
 Ctl-F9      scroll to far right
 F10         invoke menu
 Home        toggle cursor between command line and data window
 Insert      toggle between Insert and Overtype mode
 PageUp      scroll up one page
 Ctl-PageUp scroll to top
 PageDown   scroll down one page
 Ctl-PageDn  scroll to bottom
 Tab         move cursor to next column
 Shift-Tab   move cursor to previous column
 
Hot Keys on Menu items are highlighted in Red

additional notes about Keyboard:

Home Toggles the cursor between the command line and the data portion of the 
window.  Home also returns the cursor to the beginning of the command line
if the cursor is elsewhere on the command line.
The mouse can also be used to toggle between the data portion and 
command line of a window.  Click anywhere on the command line or 
copyright line to position cursor to command line.  Click anywhere on the 
data portion of the window to position cursor to data entry area.

Insert Changes the typing mode from Insert mode to Overtype mode, and back 
again (just like a Word Processor.)

Delete Deletes the character where to cursor is positioned (just 
like a Word Processor.)

Backspace Backs up the cursor and overtypes whatever is there (just like a Word 
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Processor.)  However the cursor stays in the column where you are typing.
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Formats
The Race Log system allows you to select from four pre-defined screen formats and four pre-defined report 

formats to control what type of data you wish to enter and display for each racer. 

Screen Formats
Normal format -   Name...  Class  Number  RC_1    RC_2 RC_3 ...

xxxxx       xx      xxxxxx          1          1       2

Short format -      Name...  Number
xxxxxx     xxxxxx    1-1-2-ds-4

Club format - Name...  Class     Number    Club           RC_1  RC_2 ...
xxxxxx      xx          xxxxxx     xxxxx     1         1

Country format - Name...  Class      Number    Club    Ctry         RC_1    RC_2 ...
xxxxxx       xx         xxxxxx       xxxx    xxx      1          1

The format can be changed to accommodate the amount of data you want to keep for a racer.  You can 
change from one format to another by selecting the "Format" | "Screen Format..." menu item.  For 
example if you enter data using the “Club” format and then change to the “Short” format, your data is 
still there, its just not displayed.  

The screen format is automatically saved when the fleet file is saved.  When a file is opened it will display in the last format used
when the file was saved. 

Report Formats
Normal format -   Name...  Class  Number      R_1    R_2     R_3 ...

xxxxxx       xx        xxxxxx          1        1      3

Short format -      Name...  Number  
xxxxx       xxxx        1-2-1-4-ds-2

Club format - Name...  Class      Number    Club     R_1 R_2 ...
xxxxxx      xx        xxxxxx        xxxx    1       1

Country format - Name...  Number      Club     Ctry   R_1 R_2 ...
xxxxxx       xxxxxx      xxxx    xxx     1        1

The report format is changed by selecting "Format" | "Report Format...".  The report format 
determines how the score results are displayed on the screen and on the 
printer.  The report format can be Set for the duration of the Race Log 
session, or can be Saved to make it permanent.

Customize Your Own Formats

In addition to the above fixed Formats, you may customize your own Format by selecting which Fields 
to include in your screen or report.  Select “Format” | “Select Screen Format…” or any of the Format
menu items.  Then select “( ) Build Your Own Format”.   A list of available Fields is displayed.  Just 
click the Fields you wish to keep track of and Race Log will do the rest.  You may switch back and 
forth from a Fixed format to the “Build Your Own” format.   “Name” and “Sail Number” are required.
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Fields for Screens Column Heading Required Description

Name Name………. X Sailor’s Name, 20 positions

Class Class Class or Division such as “Jr”, 
“Blu”, “Red”, etc., 3 pos

Sail Number Number X Sail Number, 6 pos

Sailing Club Club…….. Sailor’s home club, 12 pos

State St Sailor’s home State, 2 pos

Member Mbr Membership status, 1 pos

Country Ctry Sailor’s Country, 3 pos

Fields for Reports Column Heading Required Description

Name Name………. X Sailor’s Name, 20 positions

SCORE SCORE X Computed points for standings

Total Total Points before throwouts are 
subtracted, only for Low Point 
Methods, required by Hobies

Class Class Class or Division such as “Jr”, 
“Blu”, “Red”, etc., 3 pos

Sail Number Number X Sail Number, 6 pos

Sailing Club Club…….. Sailor’s home club, 12 pos

State St Sailor’s home State, 2 pos

Member Mbr Membership status, 1 pos

Country Ctry Sailor’s Country, 3 pos
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Team Scoring
Overview:

Race Log can keep track of up to 4 teams in each fleet file.  It’s easy to score Teams by specifying a 
Team for each sailor and then Scoring the fleet as you normally score.  When the Score Results 
window appears you can then Score the Teams to find out the Team ranking.

Instructions:

Go to “Format” | “Select/Setup Team Format..”   Select an appropriate Format.  See Screen Formats
and Report Formats above to review what the various Formats look like.  “Team” will be substituted 
where “Class” is shown in the Formats listed above.  Enter a Team Identifier in the Team Column (1 to
3 characters).  Then Score in a normal fashion using any of the Score Methods.  The entire fleet will be
ranked as in any non-team Scoring.

Teams are scored after you Score the whole fleet.  When the Score Result window is displayed, select 
“Score” | “Score Team..”.  The Team Standings will appear in a new window with the Total Points 
for each Team.  All Team members scores will be totaled, and then ranked.

Select Print All to print your results while the Team Standings Window is still displayed.  The Team 
Results will be printed along with the full Results if the Team scoring has been done.

The Team Standings widow will close when the Score Results window is closed.
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Helpful Tools
Calendar

A Calendar tool is provided for convenient checking of race dates.  Select the “Calendar” menu item 
from the “Help” pull down menu.   A Mouse is required to increment or 
decrement the Calendar through the Months.  Multiple instances of the 
Calendar can be created.  The “Next Window” function, or F6 will help you 
find the Calendar if other windows overlap it.

Calculator

A Calculator tool is provided for convenient checking of calculations when reviewing scores.  Select 
the “Calculator” menu item from the “Help” pull down menu.  A Mouse is 
required to operate the Calculator.  Multiple instances of the Calculator can 
be created.  The “Next Window” function, or F6 will help you find the 
Calendar if other windows overlap it.
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Window Manipulation
A partially hidden window can be brought to the front by clicking the mouse anywhere on it (just like 

MS Windows).

The F6 function key will bring the next window to the front.  You may also Mouse click the "F6 Next 
Window" item on the status line.

A window can be closed by clicking the [¢] on the upper left window border.

A window can be maximized, or restored to its original size by clicking the [é] on the upper right 
window border.

A window can be resized by dragging  with the mouse on the lower right corner of the window.

A window can be moved by dragging with the mouse anywhere on the upper border of the window.

The mouse can be used to toggle between the data portion and command line of a window.  Click 
anywhere on the command line to position cursor to command line.  Click anywhere on the data 
portion of the window to position cursor to data entry area.
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System Settings
The "System Settings" selection on the "Options" pulldown menu is where you change the Printer type 
as mentioned above.  Settings for Maximum Racers and Maximum Races are shown on this menu. 

   System Limits:
     (These settings can be left alone unless you have a very large file with a large number of racers 
and/or a large number of races.   A higher number may reduce performance, and a lower number 
means better performance )
 
   Maximum Number of Races  - This is set to 100 by default.  This means that a maximum of 100      

races can be entered for each racer into a scoring file.
 
   Maximum Number of RaceRs - This is set to 100 by default. This means that a maximum of 100  

racers can be entered into the scoring file.
 
   Select Printer Type:

- Dot Matrix (such as Panasonic KX-P1123..., etc, series)
                                        - Laser Jet (such as HP Laser Jet or Desk Jet series).
 
   Set    - sets your selections for this Race Log session.

 Save   - saves your selections so they will stay set until you change them again.
  Cancel - just cancel and don't change settings.
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******* Your Suggestions are welcome! *******

For more information contact: 
ELB Software

PO Box 463
Lake Bluff, IL 60044

phone: (847) 295-8675.
CompuServe: 74670,1435

email:  elb@compuserve.com

Internet Site: http://ourworld.compuserve.com/homepages/elb
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